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Note the following details of the code protection feature on Microchip devices:

. Microchip products meet the specification contained in their particular Microchip Data Sheet.

. Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the

intended manner and under normal conditions.

. There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

. Microchip is willing to work with the customer who is concerned about the integrity of their code.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not

mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify
and hold harmless Microchip from any and all damages,
claims, suits, or expenses resulting from such use. No
licenses are conveyed, implicitly or otherwise, under any
Microchip intellectual property rights.
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Preface

NOTICE TO CUSTOMERS

document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX" is the document number and “A” is the revision level of the

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP4725 SOT-23-6 Evaluation Board. Items discussed in this chapter include:

Document Layout

Conventions Used in this Guide
Recommended Reading

The Microchip Web Site
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP4725 SOT-23-6 Evaluation Board as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP4725 SOT-23-6 Evaluation Board and instructions on how to program the
DAC register and EEPROM of the MCP4725 device.

Appendix A. “Schematics and Board Layouts” — shows the schematic and lay-
out diagrams for the MCP4725 SOT-23-6 Evaluation Board.

Appendix B. “Bill Of Materials (BOM)” — lists the parts used to build the
MCP4725 SOT-23-6 Evaluation Board.

© 2007 Microchip Technology Inc. DS51669A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl1l8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OXFF, “A”

Italic Courier New

A variable argument

file.o, where File can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)
{ ...
}

DS51669A-page 2
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RECOMMENDED READING

This user's guide describes how to use MCP4725 SOT-23-6 Evaluation Board. The
following Microchip documents are available and recommended as supplemental
reference resources.

PICkit™ Serial Analyzer User’s Guide (DS51647)

Consult this document for instructions on how to use the PICkit Serial Analyzer
hardware and software.

MCP4725 Data Sheet, “12-Bit DAC with EEPROM Memory in SOT-23-6"
(DS22039)

This data sheet provides detailed information regarding the MCP4725 product family.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

« Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

 Local Sales Office

* Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer

for support. Local sales offices are also available to help customers. A listing of sales
offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

© 2007 Microchip Technology Inc. DS51669A-page 3
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DOCUMENT REVISION HISTORY
Revision A (October 2007)

« |nitial Release of this Document.
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Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP4725 SOT-23-6 Evaluation
Board and Instruction how to program the DAC register and EEPROM of the MCP4725
device using the PICkit Serial Analyzer. The following sections cover the following
topics:

* What is the MCP4725 SOT-23-6 Evaluation Board?

* How to use the MCP4725 SOT-23-6 Evaluation Board with the PICkit Serial
Analyzer

1.2 WHAT IS THE MCP4725 SOT-23-6 EVALUATION KIT

The MCP4725 SOT-23-6 Evaluation Board contains the MCP4725 single channel
12-Bit Digital-to-Analog Converter (DAC) and 1°c loading resistors.

The purpose of this board is:

* Quick evaluation of the MCP4725 features using the PICkit Serial Analyzer:
The user can program the DAC Register or EEPROM using the PICkit Serial
Analyzer and measure the MCP4725 device analog output voltage using a volt-
meter

» Easy handling of the MCP4725 device in a tiny SOT23-6 package: The
MCPA4725 device is available in a small SOT-23-6 package. This board makes it
easy to handle the small package device for user’s application evaluations. The
user can simply connect the J1 pins on the evaluation board to the user’s test
board for a quick evaluation of the MCP4725 device. The MCP4725 supports
standard mode (100 kHz), fast mode (400 kHz), and high speed mode (3.4 MHz).
This evaluation board is using 5 kQ for the e pull-up resistors. This 5 kQ
supports up to 400 kHz. The user can replace the R, and R3 with lower values
(less than 1 kQ) for the high-speed mode (3.4 MHZz)

1.3 GETTING STARTED WITH PICKIT SERIAL ANALYZER

The user can use the MCP4725 SOT-23-6 Evaluation Board in two different ways: (a)
together with the PICKit Serial Analyzer or (b) by connecting this board to the user’s
target board directly.

Figure 1-1 shows the MCP4725 SOT-23-6 Evaluation Board. The SCL, SDA, Vpp, and
Vgg pins in the J1 connector are connected to the MCP4725 device.

The MCP4725 SOT-23-6 Evaluation Kit contains two MCP4725 SOT-23-6 Evaluation
Boards. This board can easily be programmed using the PICkit Serial Analyzer
(DV164122). It is highly recommended that the user order the MCP4725 SOT-23-6
Evaluation Board and the PICkit Serial Analyzer at the same time.

On the MCP4725 SOT-23-6 Evaluation Board, the R, and Rj are the 12C pull-up load
resistors for the SDA and SCL, respectively. The user can replace them with their own
component values of interest. It is also recommended that these pull-up resistors be
removed if the user’s test board has the pull-up resistors already. The MCP4725
SOT-23-6 Evaluation Board also has footprints for additional pull-up resistors (in
parallel with the R, and R3) and loading capacitors. The user can populate the board
with their own components.

© 2007 Microchip Technology Inc. DS51669A-page 5
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JP1: AO selection jumper:
Picture shown here is connected to the GND (A0 = 0)

MCP4725 in SOT-23-6 package

J1 Connector
Ground Terminal

Analog Output Terminal

(Vour) .
Vpp Terminal
R1 (Pull-up Resistor for SDA)
R3 (Pull-up Resistor for SCL)
FIGURE 1-1: MCP4725 SOT-23-6 Evaluation Board.
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131 Getting Started with PICkit Serial Analyzer

This section describes how to evaluate the MCP4725 device using the PICKkit Serial
Analyzer.

1.3.1.1 HARDWARE SET-UP

1. Connect the MCP4725 SOT-23-6 Evaluation Board and the PICkit Serial
Analyzer together using the J1 connector.

2. Connect a USB cable between the PICkit Serial Analyzer and a Personal
Computer.

3. Connect a Digital Voltmeter to Vgt and GND terminals on the MCP4725
SOT-23-6 Evaluation Board. Figure 1-2 shows the connection example.

MCP4725 SOT-23-6 Evaluation Board

PICkit Serial Analyzer Analog Output Voltage (VouT)
Connected to Voltmeter

USB Cable: Connected between the PicKit Serial analyzer and Personal Computer.

FIGURE 1-2: MCP4725 SOT-23-6 Evaluation Board Test Set Up.

© 2007 Microchip Technology Inc. DS51669A-page 7
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1.3.1.2 PICKIT SERIAL ANALYZER PC SOFTWARE SET-UP FOR DAC DEVICE
PROGRAMMING AND ANALOG VOLTAGE OUTPUT MEASUREMENT

1. Install the PICkit Serial Analyzer software in your computer.
Connect the USB cable between the PICkit Serial Analyzer and your PC.

3. Runthe PICkit Serial PC Software: It will open up the following graphic user inter-
face (GUI). Click Next > and follow the instructions:

Configuration Wizard E

Welcome To The
PICkit Serial Analyzer
Configuration Wizard

The following steps will guide you through the
zetup of the PICKkE Senal Analyzer.

n

E EwnE

EIFET

| Mesut » | Cancel

4. Selectthe I2C Master option radio button for the Communication Mode type and
click the Next > button.

Configuration Wizard E

Communication Mode - Page 1 of 4

Chooge which mode of communication you wizh b uze.

0

[2C Master

" 5Pl Master

" USART Async

" USART Sync Master

¢ Back eut » Cancel

DS51669A-page 8 © 2007 Microchip Technology Inc.
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5. Select either 100 kHz option or 400 kHz option radio button and click the Next >
button.

Configuration Wizard E

Communication Speed - Page 2 of 4
Select your [2C communication zpeed

Communication speed may alzo be
I 100kHz  adjusted by using the 'Configure
¥ 400 kHz hMode' page from the 'PICkIt Serial
Analyzer menu dropdowen after
completing the Configuration
Wfizard.

¢ Back Memt > Cancel

Note: The MCP4725 SOT-23-6 Evaluation Board supports the 12C bus data rate
up to 3.4 MHz, but the current version of the PICkit Serial Analyzer only
supports the 12C bus data rate up to 400 kHz.

6. Select No on Device Pullups and click the Next > button.

Note: The MCP4725 SOT-23-6 Evaluation Board has its own pull-up resistors

Configuration Wizard E

Device Pullups - Page 3 of 4

Do vou need to enable pullupz for your device?

Enable Pullupz
" Yez ™ Mo

¢ Back Mext » Cancel

© 2007 Microchip Technology Inc. DS51669A-page 9
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7. Select the Voltage Source option for the MCP4725 SOT-23-6 Evaluation
Board and click the Next > button.

Case 1: When you use Vpp from the PICkit Serial Analyzer:

If you choose PICKit Serial will power my device option, and the 5 Volt option
as shown below, the MCP4725 SOT-23-6 Evaluation Board is powered by the 5
VDC from the PICkit Serial Analyzer through the J1 connector. In this case, make
sure that the JP2 jumper on the MCP4725 SOT-23-6 Evaluation Board is con-
nected.

You can also click on the Other option and move the slide bar for other than
5 volts.

Case 2: When you use your own Vpp:

If you want to provide your own Vpp voltage through the Vpp terminal on the
MCP4725 SOT-23-6 Evaluation Board, then do not select the PICKkit Serial will
power my device option. In this case, you have to remove the JP2 jumper on
the board and provide the Vpp at the Vpp terminal.

Configuration Wizard E

Yoltage Source - Page 4 of 4

Does PICKkE Senal need to power your device?

Yoltage

w FICkit Serial wil

power my device ) L
IF PICKit Serial will povwer your

s Bial device, zelect the checkbox ta
™~ Other the left, then determine pour
violtage.

a0

< Back Mest » Cancel

DS51669A-page 10 © 2007 Microchip Technology Inc.
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8. Click the OK button. You have done all PICKkit Serial Analyzer Configuration
Set-up. You are now ready to program the MCP4725 device using the PICkit

Serial Analyzer.

Configuration Wizard E

You're Done!

Prezz '0FK' ta complete the Configuration ‘wizard.

[ Do not show this wizard on startup again

“Wwizard may be accessed anytime Fram
menu dropdown PICKE Senal Analpzer -»
Fun Confiquration wizard.

Ok

© 2007 Microchip Technology Inc. DS51669A-page 11
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1.3.2 Creating Script File to program the DAC Register and EEPROM
Data

1. From the Communications tab, select the Script option and go to the Script
Builder.

1 P|Ckit Serial - 12C Master Mode

Communications | FICkt Sevial Analvzer  CemoBoards  User Defined Templates  Yiew  Window  Help

Basic Cperations sic Operations | Resat -‘I‘M
Seripk Sieript Builder o

W Update

I Executive Emar
W Communicztion Eror
W 12C Emor

Seript Execute

1 | i
Transactions EitRate: 100.0kHz

Sowree Voltage: 4.5
Dt Line Waltage: 484
Clock Line oltage: 4.7

File » Edit = Clear

02/13/2007 4:59:14 PH

Welcome to PICkit Serial version 2.0.1.0

Found PICkitS.d11 - Ver: 1.3.0.0

Found PICkit Serial Analyzer - FW Ver: 0xD108
1158 cantral block updated with preference data.

Basic View Set.

DS51669A-page 12 © 2007 Microchip Technology Inc.
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2. You need to create a script file using the following instructions.
a) Type in any script name (i.e., MCP4725_Write) in the space below the Script

Name menu item.

b) Type in the following parameters in order in the text box area provided in the

Script Detail box.

Script Detail

[2CSTART
[2CWRTBYT
03

Co

08

00

[2CSTOP

----------- > This means there are three bytes to send
........... > 1st Write Byte: Address byte = 1100-0000
----------- > 2nd Write Byte: 0000-1000
........... > 3rd Write Byte: 0000-0000

Note: You can choose any data you want for the 2nd and 3rd write bytes. If you
use the above write data, the MPC4725 device will output:
VOUT = VDD *0.5V.

1 PICkit Serial - 12C Master Mode

Script Builder

Seript Hame FieadAddraB

Execute Script |
Clear Script |

Del User Scripts |
Show Array |

Communications ~ PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Window  Help

View: Basic | Communications: Basic Operations |~ Reset 12C_M

[~ Example 12C Serpts — 1 Seript Detail User |2C Seripts

MCP4725 Wiite ”a“ddf
W ited lockAddide
ReadBlockdddiad

- Status
I Update
I Executive Error
lE u B Communication Error
B 12C Error
EitRate: 100.0 kHz

T MCP4725_‘wiit Source Yoltage: 4.9
EESESIT il Data Line Voltage: 4.7V

12CwWRTEYT 1st Write Byte Clack Line Voltage: 434/

2nd Write Byte

|2C5TOP 3rd Write Byte

[5_1[P-]

5:00:55 PM Sent script from Script Builder page,
bytes:

[5-1W_] @3] [co] (@8] f00] [P_]

Script 'MCP4725_Write' successtully updated.

© 2007 Microchip Technology Inc.
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Programming DAC Register (Fast Mode)
a) Change 2nd and 3rd data bytes you want in the Script Detail.
b) Click Execute Script Menu item.

c) The device gives an analog output voltage (VgoyT) at the VOUT terminal on
the board.

il PICkit Serial - 12C Master Mode

Communications  PICkit Serial Analvzer  Demo Boards  User Defined Templates  Wiew  Window — Help

Wigw: Basic | Communications: Basic Operations  Reset

I

— Erample I2C Scriptz —— [ Script Detaill — User |2C Scripts
Script Hame Readfddraf [ZC5TART 1=l MCPA725_ Wite
IMEF‘4?'2EEDard [ Writedddid s - MCPA725_EEWite
- WwiiteBlockaddriB [20WRTEYT MCP4725 Read
ReadBlockAddisd . = MCP4725 Fead EE

MCP4725B 0ard W

Save Script |
- Co x
Clear Script | oo x (==

[2CSTOP

Del User Scripts | X
Show Amay |

1M Transactions

File = Edit = Clear
03 /16,2007 4:36:29 PM

welcome to PICkit Serial wersion 2.0.1.0

Found PICkits.d11 - Wer: 1.3.0.0
Found PICkit Serial Analyzer - FW Ver: Ox0108
USE control block updated with preference data.
Basic Wiew Set,

4:37:17 PM
bytes:

sent script from Script Builder page, 10

(-1 [e3] (o] [o4] (o] [P_]
(=-10r]

DS51669A-page 14
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4. Programming DAC Register and EEPROM

a) Type in the following parameters in order in the spaces below the Script
Detail menu and click on the Execute Script button.

Script Detail

I2CSTART

I2CWRTBYT

04 | e > This means Master will send four bytes
1o R — > 1st Write Byte: Address byte = 1100-0000
60 | e > 2nd Write Byte: 0110-0000

1 D > 3rd Write Byte: 1000-0000

070 JN [— > 4th Write Byte: 0000-0000

I2CSTOP

t Serial - 12C Master Mode

cations  PICkit Serial Analyzer  Demo Boards  User Defined Templates  MWiew  Window  Help

ic | Communications: Basic Operations | Resek

REL

Example 12C Scriptz —— 1 SenptDetal ———————— 1 Uzer 12C Scrpts
cript M ame Feadtddidd - FMCPA725 wirite
725 E Ewrite Writ&ﬁ.ddrﬁg ACBURY MCP4725 EEWrite

WriteBlockAddrdg [2CWRTEYT MCP4725_Read

N FeadBlockAdditd 04 = MCP4725_Read EE
wve Script MCP47 258 0ard W
. |y |CO x
cute Script I( 1st Write Byte ) — % = -
- P
ear Script |< 2nd Write Byte ) s a0 x|
T
( 3rd Write Byte > / oo *
T [2CSTOP

Uzer Scripts

4'( 4th Write Byte ) x

nowe Arrap

nsactions

dit = Clear
—d

B PM sent script from Script Builder page, 11

| 124 [Co] [eo] [eo] [20][P_]
]
B PM sent script from Script Builder page, 11

L] [04] [Co] [60] [eo] [00] [P_]

© 2007 Microchip Technology Inc. DS51669A-page 15
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5. Verifying the EEPROM Data.

After sending the EEPROM write command in Step 4, the device holds the data in the
EEPROM. The data in the EEPROM is non-volatile. To check this non-volatile data, you
can remove the Vpp from the MCP4725 SOT-23-6 Evaluation Board once, and bring
back up the Vpp again. You will see the same analog voltage output at the Vo1
terminal.

DS51669A-page 16 © 2007 Microchip Technology Inc.
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6. Reading the DAC Register Data using the PICKkit Serial Analyzer
This experiment can be done in two steps:
(@) Write the DAC Register with Fast Mode Command.

(b) Send Read Command and see the results on the PICkit Serial Transactions
page.

Communications  PICkit Serial Analvzer  Demo Boards  User Defined Templates  Yiew

View: Basic | Communications: Basic Operations = Resel

Script Builder

Example |2C Scripts Script Detail Izer
Script Mame R eadddidd =l M CF4
|M|:F'4?25 Fead Witedddrd g ||2I:STAHT P
= WiriteBlockaddisg |I2E"-.-'JF|TEYT MCP4
i FeadBlockaddisd |EI1 " MCP4
Save Script | | MRS
C1 x
| Execute Scnpt | |I2EHDB'T’TNLE
Clear Script | |3  —
|12C5TOR

Requesting
3 Bytes

Del User Scripts |

Show Array |

NG

File = Edit = Clear

F:30:40 PM sent script from Script Builder page, 10
bytes:

_ Writn_an Data
[5_1[W_1[03] [C0] [08] [00] [F_] using a Write Command
[=_10P_1

script 'MCP4725_FRead' successfully updated.

F:32:21 PM sent script from Script Builder page, 10
bytes:

Reading Data
using a Read Command

(5 IMW_J[01][C1][rRN][03][P_]
(s_J[col[eol@o]rP_]

© 2007 Microchip Technology Inc. DS51669A-page 17
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7. Reading both the DAC Register and EEPROM data.
This experiment can be done by two steps:
(a) Write the DAC Register and EEPROM data using a write command.

(b) Send Read Command (Request 5 bytes) and see the results on the PICkit
Serial Transactions page.

Communications  PICkit Serial Analyzer  Demo Boards  User Defined Templates  Wiew  Windo

View: Basic =~ Communications: Basic Operations | Reset

Script Builder

Example I2C Scripts Script Detail |Jzer 12C 9
Script Mame Readbddidg =l MCP4725 ]
|M|:F'4?25 Fead EE Writedddrsg ||2I:ST'&'HT MCP4725 ]
- = WwiiteBlockaddad |I2EWF|TE'T’T MCP4725
. ReadBlockaddig |EI1 " MCP4725
Save Script | | MCF47 258
1 »
| Execute Scnpt | |I2EHDBYTNLE
Clear Script | Requesting |5 x|
5 Bytes I2CSTOP
Del Uszer Scrpts | | x

Show Array |

l|[
ol

File = Edit = Clear

Written Data
using a Write Command

fG:41:13 PM Sent script from
bytes:

1pt Builder page, 11

(5 JMw_][04] [CO][60] [80] (00T [P_]

DAC
[s_1[rP_1 Register Data EEPROM Data
Gid41:27 PM Zent script from/Ecript Builder page, 10
bytes:

[5_10w_] [CIl] 1] [RN] [os1p_1 Reading Data

using a Read Command

DS51669A-page 18 © 2007 Microchip Technology Inc.
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1.3.3 Examples of the MCP4725 Programming

1 1 0o | o A2 | Al | AO | RIW
Device Code Address Byte *

* Address Byte: A2 = Al = 0 for Default Samples
A0 = 0 if AO pin is Grounded

= 1if AO pinis tied to Vpp
EXAMPLE:

Write Mode: OXCO FOR (A2 = Al = A0)
0XC2 FOR (A2 =A1=0,A0=TIED TO Vpp)

Read Mode: 0XC1 FOR (A2 = A1 = AQ)
0XC3 FOR (A2 = A1 =0, A0 = TIED TO Vpp)

FIGURE 1-3: MCP4725 Device Address Byte.
Vv xD 1
DAC Output = ~REEZZN = SV x2° _ 5 5y
4096 4096

Start | 0xCO 0|0 |PD1|PDO0O|D11|D10|D9| D8 D8/ D7|D6|D5| D4 |D3 | D2

Address Byte:

when A2=A1=A0=0 Owo

=2

FIGURE 1-4: Fast Mode (Write Command) for Vot = 2.5V when Vggg = 5V.

© 2007 Microchip Technology Inc. DS51669A-page 19
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DAC Output =

Verer XDy _ 5V x2t

4096

4096

= 2.5V

Start

0xCO

.DllDlO D9|D8| D7 |D6 | D5 D4.

f

0x60

0|1| 1| X | X |PD1|PDO| X

When A2=A1=A0=0

D3

D2

D1

DO

X

X l STOP

~

0x00

FIGURE 1-5:
VREF =5V.

Write Command Example for EEPROM and DAC Register for Vo1 = 2.5V when

DS51669A-page 20
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Appendix A. Schematics and Board Layouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP4725
SOT-23-6 Evaluation Board:
» Board — Schematic
» Board — Top Layer
« Board — Top Silk Layer
« Board — Bottom Metal Layer

© 2007 Microchip Technology Inc. DS51669A-page 21
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BOARD - SCHEMATIC
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A.3 BOARD-TOP LAYER
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A.4 BOARD - TOP SILK LAYER
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A5 BOARD-BOTTOM LAYER
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NOTES:
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Appendix B. Bill Of Materials (BOM)

TABLE B-1: BILL OF MATERIALS (BOM)

Qty Reference Description Manufacturer Part Number
C1,C2 Not Populated — —
3 GND, VDD TEST POINT PC COMPACT SMT Keystone Electronics 5016
VOUT
1 J1 CONN HEADER 6POS .100 R/A Molex/Waldom Electronics | 22-28-8062
GOLD Corp
2 JP1,JP2 CONN HEADER 2POS .100 VERT Molex/Waldom Electronics | 22-28-4020
TIN Corp
2 JP1,JP2 CONN JUMPER SHORTING GOLD | Sullins Electronics Corp. SPC02SYAN
FLASH
1 PCB RoHS Compliant Bare PCB, — 104-000149
MCP4725 SOT23-6 Eval Board
2 R1,R3 RES 4.99K OHM 1/8W 1% 0805 SMD | Panasonic® - ECG ERJ-6ENF4991V
2 R2,R4 Not Populated — —
1 Ul MCP4725_SOT-23-6 Microchip Technology Inc. | MCP4725_SOT-23-6

Note 1. The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM
used in manufacturing uses all RoHS-compliant components.
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